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1 Introduction 

ProHawk® Vision Server Client 
 
The ProHawk® Vision Server Client Users Guide provides an overview for the ProHawk Vision Milestone 
XProtect Smart Client Plugin. It is designed to directly integrate with the Milestone XProtect Smart Client. 
We have tried to make this overview clear, easy to understand, and informative. We value the 
relationship that we have with our users and believe this guide with be valuable in expediting the setup 
of ProHawk Vision Server. 
 
ProHawk Vision Milestone XProtect Smart Client Plugin receives video from a recorded Milestone Server 

camera, or a Milestone XProtect VMS Server to improve. ProHawk Vision provides an automatic 

restoration along with various preset and detailed restoration parameters that can be changed by 

accessing the ProHawk Vision Plugin in the Milestone XProtect Smart Client. Automatic and One-Click 

filter preset radio buttons assist users in clarifying challenging visual conditions. ProHawk Vision 

advanced filters settings allow users to adjust the ProHawk parameters individually. These are specific 

adjustments that may have an impact on details to be revealed.  

Once the video stream is selected, ProHawk Vision provides several options to view the original and/or 

improved picture or video: Improved; Original and improved picture or video side-by-side; Improved 

with original preview. 

The current video frame or picture can be saved to the Windows clipboard and users Pictures\ProHawk 

folder on both video ProHawk improved and original stream types. The ProHawk Vision Milestone 

XProtect Smart Client Plugin provides media player controls for video control and record capabilities. 

This allows users to Play, Pause, Forward, Rewind, Stop, or Record the input video. The improved video 

can also be recorded to a file for future use. 

This is the 6.0.0 release of ProHawk Vision Milestone XProtect Smart Client Plugin. 
 



 

2 System Requirements

Following are the systems requirements for ProHawk Vision Milestone XProtect Smart Client Plugin to 
operate properly: 

• 64-bit Multicore CPU 

• 8GB RAM (16GB or more recommended; 2GB per stream recommended) 

• Windows 10, Windows Server 2012, Windows Server 2016, Windows Server 2019, Ubuntu 18.04.3 

LTS, Ubuntu 20.04.1 LTS 

• NVIDIA Quadro, Tesla, GRID, GeForce or RTX products with Kepler, Maxwell, Pascal, Turing, Volta or 
Ampere generation GPUs 

ProHawk Vision Milestone XProtect Smart Client Plugin includes and requires the following external libraries: 

• Microsoft Visual C++ 2015-2019 Redistributable (x64) runtime 

• Microsoft .NET Framework 4.8 Redistributable 

• NVIDIA CUDA 11.0 

• OpenCV 4.4.0 – OpenCV 4.4.0 and lower versions are licensed under the 3-clause BSD license. See 

license information at https://opencv.org/license/ 

• FFMPEG - This software uses libraries of FFmpeg licensed under the LGPLv2.1 

ProHawk Vision Milestone XProtect Smart Client Plugin supports 64-bit (x64) architectures. ProHawk Vision 
does not support 32-bit (x86) architectures. 
 

https://opencv.org/license/
http://ffmpeg.org/
http://ffmpeg.org/
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html
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3 Directories & Files 

There will be several directories created after extracting the ProHawk Vision Server setup into the 
C:\Program Files\ProHawk\Vision Server main folder. Following are the folders and their descriptions: 

Folder Description 

docs 
Documentation files: ProHawk Vision Milestone XProtect Smart Client Plugin 
Users Guide.pdf. 

ProHawk. 
InstantVisualClarity. 
Plugin 

A folder containing the ProHawk Vision Milestone XProtect Smart Client 
Plugin and associated files and folders to run. This is typically located off the 
C:\Program Files\Milestone\XProtect Smart Client\MIPPlugins directory 
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4 ProHawk Vision Milestone XProtect Smart Client Plugin 

The ProHawk Vision Milestone XProtect Smart Client Plugin is designed to directly integrate with 
Milestone XProtect Smart Client. Once added to the users’ setup, the plugin displays both unenhanced 
and ProHawk enhanced video streams. Figure 89 below shows the ProHawk Vision Milestone XProtect 
Smart Client Plugin. 

 

Figure 89 

  



  

 
Page 7 of 37 

ProHawk Technology Group, Inc. 
ProHawk Vision 5.0.0 

 Loading Plugin into a Camera View 

To use the ProHawk Vision Milestone XProtect Smart Client Plugin, the first step is to make the ProHawk 
Vision Milestone XProtect Smart Client Plugin available in the Milestone XProtect Smart Client View(s). 
The following series of steps will enable the ProHawk Vision Milestone XProtect Smart Client Plugin in 
the Milestone XProtect Smart Client View(s) selected. Click on the Setup button near the upper right-
hand corner of the Milestone XProtect Smart Client. (Figure 90)  

 
Figure 90 
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The Setup function will provide a System Overview section, with a MIP SDK Samples option. The 
ProHawk Vision Milestone XProtect Smart Client Plugin is in the MIP SDK Samples folder. Click on the 
Arrow next to the MIP SDK Samples option, this will expand the MIP SDK Samples folder and expose 
the plugins available. (Figure 91)  

 
Figure 91 

When expanded, the MIP SDK Samples folder shows the plugins that are available, including the 
ProHawkXProtectPlugin. (Figure 92) 

 
Figure 92 

Next, select the Milestone XProtect Smart Client View that you want to add ProHawk Vision capabilities 
too. (Figure 93)  
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Figure 93 

Once the Milestone XProtect Smart Client View that you want is selected, drag the 
ProhawkXProtectPlugin into the View pane to the right. (Figure 94)  

 
Figure 94 

 Loading Plugin into Multiple Camera Views 

To use the ProHawk Vision Milestone XProtect Smart Client Plugin in a multi-camera Milestone XProtect 
Smart Client View, the first step is to make the ProHawk Vision Milestone XProtect Smart Client Plugin 
available in the Milestone XProtect Smart Client View(s). The following series of steps will enable the 
ProHawk Vision Milestone XProtect Smart Client Plugin in the Milestone XProtect Smart Client View(s) 
selected. Click on the Setup button near the upper right-hand corner of the Milestone XProtect Smart 
Client. (Figure 95)  
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Figure 95 
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The Setup function will provide a System Overview section, with a MIP SDK Samples option. The 
ProHawk Vision Milestone XProtect Smart Client Plugin is in the MIP SDK Samples folder. Click on the 
Arrow next to the MIP SDK Samples option, this will expand the MIP SDK Samples folder and expose 
the plugins available. (Figure 96)  

 
Figure 96 

When expanded, the MIP SDK Samples folder shows the plugins that are available, including the 
ProHawkXProtectPlugin. (Figure 97) 

 
Figure 97 
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Next, select the multi-camera Milestone XProtect Smart Client View that you want to add ProHawk 
Vision capabilities too. (Figure 98)  

Once the multi-camera Milestone XProtect Smart Client View that you want is selected,dDrag the 
ProhawkXProtectPlugin into each of the two View panes to the right. (Figure 99)  

 
Figure 99 

 
 
 

Figure 98 
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 Media Menu 

Once the ProhawkXProtectPlugin has been dragged into the View pane it will be displayed in the 
selected View pane as shown in the image below. The ProHawk Vision Milestone XProtect Smart Client 
Plugin Media menu provides two options to view live video streams or stored media files. (Figure 100) 
The four Media menu options are: 

• Open Video Source… 

• Close Video Source 

• Open Recorded Source… 

• Open Recording Folder… 

Figure 100 

This section of the ProHawk Vision Users Guide will describe the ProHawk Vision Milestone XProtect 
Smart Client Plugin Media menu options above. (Figure 100) 
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 Open Video Source 

The first step is to select a video source to view. To select a live Milestone XProtect VMS video stream to 
view in the ProHawk Vision Milestone XProtect Smart Client, click on the Media menu, then click on the 
on the Open Video Source menu option. (Figure 101) 

The ProHawk Vision Milestone XProtect Smart Client Plugin Open Video Source menu choice will open 
the Camera Source Selection dialog box that will allow you to select a Milestone XProtect VMS Server 
video stream, as can be seen below in Figure 102. 

  

Figure 102 

Figure 101 
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 Close Video Source 

The Close Video Source, Media Menu option allows you to close a source selected. This option is 
available when the Operator View Menu option is enabled. To close a video source, click on the Close 
Video Source, Media Menu option. (Figure 103) 

 
Figure 1 

 Open Recorded Source 

The Open Recorded Source, Media Menu option allows you to select a recorded video in the Milestone 
XProtect Server by specifying the camera and time/date range to load. (Figure 104) 
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Figure 2 

In Recorded Media Source Selector dialog box, click on the Camera Source button. (Figure 105) 

 
Figure 3 

In the Camera Source Selector dialog, click on the recorded camera source you want. (Figure 106) 



  

 
Page 17 of 37 

ProHawk Technology Group, Inc. 
ProHawk Vision 5.0.0 

 
Figure 4 
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Figure 6 

In Recorded Media Source Selector dialog box, select the From and To dates of the video. (Figure 107) 

In the Recorded Media Source Selector dialog box, click on the Start button. (Figure 108) 

Figure 5 
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Figure 110 

 Open Recording Folder 

To Open a previously recorded ProHawk Vision restored file, click on the Media menu, then click on the 
Open Recording Folder menu option to allow selection of the desired file. (Figure 109) 

 
Figure 109 

Double-click on the restored ProHawk Vision file in the file selection dialog box to load the desired file. 
(Figure 110) 
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 Edit Menu 

The ProHawk Vision Milestone XProtect Smart Client Plugin Edit menu allows you to copy the current 
video frame or picture to the Windows clipboard and users Pictures\ProHawk folder on both video 
ProHawk enhanced and original stream types. (Figure 111) 

 

Figure 111 

This section of the ProHawk Vision Users Guide will describe the ProHawk Vision Milestone XProtect 
Smart Client Plugin Edit menu options above. (Figure 111) 
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 Copy 

Click on the Edit menu, the click on the Copy menu option, then click either the Original or ProHawk 
menu option to copy the current video frame as an image file to the Windows clipboard and to the 
current users’ desktop. (Figure 112)  

Copy->Original – Saves the displayed source image to the clipboard and the current users’ desktop 

Copy->ProHawk – Saves the displayed enhanced image to the clipboard and the current users’ desktop  

Figure 112 
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 Options Menu 

ProHawk Vision Milestone XProtect Smart Client Plugin provides an Options menu to control 
enhancement, recording, voice commands, and default folders. (Figure 113) The Options menu options 
and their default Options settings are: 

• Disable Enhancement – Enable/Disable 

• Enable 2X Enhancement – Disable/Enable 

• Standard Filter Preset – Standard 

• Custom Tiler Preset - None 

This section of the ProHawk Vision Users Guide will describe the ProHawk Vision Milestone XProtect 
Smart Client Plugin Options menu options above. (Figure 113) 

  

Figure 113 
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 Enable/Disable Enhancement 

ProHawk Vision Milestone XProtect Smart Client Plugin defaults to the Enable/Disable Enhancement, 
Options menu being unselected. This sets the ProHawk Vision engine On. When the Enable/Disable 
Enhancement, Options menu is unselected, there will be no checkmark next to the menu option. (Figure 
114) To turn the ProHawk Vision engine Off, click on the Enable/Disable Enhancement, Options menu 
choice.  

Figure 114 
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When the Enable/Disable Enhancement, ProHawk Vision Milestone XProtect Smart Client Plugin 
Options menu is selected, it will display a checkmark next to the Enable/Disable Enhancement, Options 
menu choice. This sets the ProHawk Vision engine Off. (Figure 115) To turn the ProHawk Vision 
restoration engine On, click on the Enable/Disable Enhancement, Options menu choice.  

Figure 115 
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 Enable 2x Enhancement 

 ProHawk Vision Milestone XProtect Smart Client Plugin defaults to the 2x Enhancement, Options menu 
being unselected. This sets the ProHawk Vision engine in a normal mode of operation. When the 2x 
Enhancement, Options menu is unselected, there will be no checkmark next to the menu option. (Figure 
116) To run the imagery through the ProHawk Vision engine twice, click on the 2x Enhancement, 
ProHawk Vision Milestone XProtect Smart Client Plugin Options menu choice.  

Figure 116 
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When the ProHawk Vision Milestone XProtect Smart Client Plugin 2x Enhancement, Options menu is 
selected, it will display a checkmark next to the 2x Enhancement, Options menu choice. This sets the 
ProHawk Vision engine in a two-pass mode where the imagery is run twice through the ProHawk Vision 
engine. (Figure 117) To turn the ProHawk Vision two-pass mode Off, click on the 2x Enhancement, 
Options menu choice. 

  

Figure 117 
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 Standard Filter Preset 

The ProHawk Vision Milestone Xprotect Smart Client Plug provides a Standard Filter Preset, Options 
Menu option containing one click preset adjustments for problematic video. Filter Preset selections 
assist users in clarifying challenging visual conditions. (Figure 118) 

The problem conditions include: 

• BACKLIGHT 

• DIRT 

• FOG 

• HEADLIGHT 

• INFRARED 

• LOWLIGHT 

• NIGHT 

• RAIN 

• SAND 

• STANDARD 

• SNOW 

• SMOKE 

• SUNGLARE 

• UNDERWATER 

• WINDOW TINT 

 
Figure 118 

Click on the Options Menu, then click on the Standard Filter Preset, Options Menu item to expose the 
dropdown list of Preset Conditions. Select the Preset Condition to restore your video.  
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 Custom Filter Preset 

The ProHawk Vision Milestone XProtect Smart Client Plugin provides a Custom Preset, Options Menu 
containing detailed restoration settings that have been saved filters by the administrator. (Figure 119)  

 
Figure 7 

Click on the Options Menu, then click on the Custom Filter Preset, Options Menu item to expose the 
dropdown list of Custom Preset Conditions. Select the Custom Preset Condition to restore your video.  
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 View Menu 

ProHawk Vision Milestone XProtect Smart Client Plugin provides several viewing options accessible 
through the View menu (Figure 120). The available View menu options and their default View options 
settings are: 

• Advanced Filter Settings – Off 

• Enhanced View - On 

• Side-by-Side View - Off 

• External Enhanced View - Off 

• Unenhanced External View – Off 

• Administrator 

• Operator 

Figure 120 

This section of the ProHawk Vision Users Guide will describe the ProHawk Vision Milestone XProtect 
Smart Client Plugin View menu options above. (Figure 120) 
  



  

 
Page 30 of 37 

ProHawk Technology Group, Inc. 
ProHawk Vision 5.0.0 

 Advanced Filter Settings 

ProHawk Vision Milestone XProtect Smart Client Plugin Advanced Filters Settings allows user to adjust 
the ProHawk parameters individually. To display and access the Advanced Filter Settings, click on the 
ProHawk Vision Milestone XProtect Smart Client Plugin View menu, then click on the ProHawk Vision 
Milestone XProtect Smart Client Plugin Advanced Filter Settings menu option. This will display the 
Advanced Filter Settings Section in the user interface. (Figure 121) 

Figure 121 
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 Enhanced View 

The ProHawk Vision Milestone XProtect Smart Client Plugin View menu, Enhanced View menu option is 
turned ON by default. (Figure 122) The Enhanced View menu option toggles the ProHawk Vision 
restoration filter ON and OFF. Click on the Enhanced View menu option to select restoration.  

Figure 122 
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 Side-by-Side View 

The ProHawk Vision Milestone XProtect Smart Client Plugin View menu Side-by-Side View menu option 
is turned OFF by default. (Figure 123) The Side-by-Side View menu option toggles the ProHawk Vision 
user interface display between one video, and a side-by-side videos. Click on the View menu, Side-by-
Side menu choice to toggle the display.  

 
  

Figure 123 
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When the ProHawk Vision Milestone XProtect Smart Client Plugin 
Side-by-Side View menu option is selected, it will toggle the Enhanced View menu option OFF, as the 
Side-by-Side View menu option display both the original and enhanced streams together. ProHawk 
Vision will simultaneously display both the original (source) stream on the left and the restored 
(enhanced) stream on the right. The example below shows how the user interface displays the imagery 
side-by-side. (Figure 124) 

  

Figure 124 
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 External Enhanced View 

ProHawk Vision Milestone XProtect Smart Client Plugin provides the External Enhanced View, View 
menu option, to open a separate window with only that ProHawk Vision enhanced imagery displayed. 
Click on the External Enhanced View, View menu option. This will allow you to view a ProHawk Vision 
enhanced video stream in full screen mode. (Figure 125) 

Figure 125 

ProHawk Vision Milestone XProtect Smart 
Client Plugin opens the External Enhanced 
View separate window with only the 
ProHawk Vision enhanced live video stream 
being displayed. (Figure 126)  

Figure 126 
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 External Unenhanced View 

ProHawk Vision Milestone XProtect Smart Client Plugin provides the External Unenhanced View, View 
menu option, to open a separate window with only that native original imagery displayed. Click on the 
External Unenhanced View, View menu option. This will allow you to view a ProHawk Vision original 
video stream in full screen mode. (Figure 127)  

Figure 127 

ProHawk Vision Milestone XProtect Smart 
Client Plugin opens the External 
Unenhanced View separate window with 
only the original live video stream being 
displayed. (Figure 128) 
  

Figure 128 
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 Administrator View 

The Administrator View in the ProHawk Vision Milestone XProtect Smart Client Plugin in designed for 
the network administrator. It contains additional capabilities, features, and functions that are not 
available in the Operator View. (Figure 129) The Administrator View provides these additional 
capabilities: 

• Control Section – Stop & Record Controls 

• Media Information Section – Metadata Fields from the Media 

• Performance Section – ProHawk Vision Engine Performance Measurements 

• Progress Section – Frame & Bytes Counts 

• Custom Preset Section – Save & Delete Custom Preset Conditions 

• Advanced Filter Setting Section – Restoration Detailed Parameter Controls 

 
Figure 129 
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 Operator View 

The Operator View in the ProHawk Vision Milestone XProtect Smart Client Plugin in designed for the 
Milestone Operator. It contains only capabilities designed for an Operator to use to eliminate screen 
clutter and keep as much display available for the video window. (Figure 130) The Operator View 
provides these capabilities: 

• Menu Bar – Media, Edit, Options, View, & About 

• Restored or Side-by-Side Video Windows 

 
Figure 8 

 

 About Menu 

The ProHawk Vision Milestone XProtect Smart Client Plugin 
application provides an About menu that provides access to 
license key information. The license key information that is 
display in the dialog box is the expiration date of the license. 
(Figure 131) 
 
 
 

Figure 131 


